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GETTING STARTED WITH NEO SHARE

Using NEO Share, you can easily send text or files to NEO 2 users and receive 
files back from them as you work with your group or classroom. You can use 
NEO Share on your computer desktop, with a standard whiteboard and a 
projector, or with an interactive whiteboard.

If you have any questions, email us:

• US, Asia/Pacific, Canada, and Latin America: support@renlearn.com

• UK, Europe, Middle East, and Africa: UK-help@alphasmart.com

What  You Need Before  You Star t

To use NEO Share with NEO 2, you need to have the following:

• A computer to run the software

• A Renaissance Receiver connected to that computer

• One or more NEO 2s running System 3.8 or higher

It’s a good idea to give your Receiver a unique name in the Renaissance 
Wireless Server Utility if you have more than one Receiver within range of the 
NEO 2s. To find out how to connect your Renaissance Receiver and give it a 
unique name, see the NEO 2 Quick Guide or the NEO User Manual.

Ins ta l l ing  NEO Share

On Windows Computers

1. Insert the NEO Share CD into your computer.

1. Double-click the NEO Share setup.exe file on the CD.

2. Click Next > in the Wizard that appears.

3. Read the license agreement. (You can print it if necessary.) When you’re 
ready to continue, click I accept the terms in the license agreement. 
Then, click Next >.

4. Click Install.

5. Click Finish when the installation is complete.

6. You may need to restart your computer. If so, a message will notify you. 
Click Yes if you want to restart now or No if you want to wait until later.

The Renaissance 
Receiver range is 
150 feet (about 45 m).
1
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G E T T I N G  S T A R T E D  W I T H  N E O  S H A R E

Starting the Software

. .
 . 

. .
On Macintosh Computers

1. Insert the NEO Share CD into your computer.

2. Double-click NEO Share Installer on the CD.

3. Enter the administrator user name and password for the computer; then, 
click OK.

4. Read through the NEO Share license. (You can print it or save it using the 
buttons on the screen.) Click Continue.

5. Click Agree to agree to the terms of the license.

6. Click Install in the NEO Share Installer. The software will be installed, and 
the folders for this program and the Renaissance Wireless Server Utility 
will open.

Star t ing  the  Sof tware

How to Star t  the Sof tware

On Windows computers, click Start  NEO Share  NEO Share.

On Macintosh computers, open the Applications folder, then the NEO Share 
folder, and double-click NEO Share.
2
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G E T T I N G  S T A R T E D  W I T H  N E O  S H A R E

Starting the Software

. .
 . 

. .
Register ing the Sof tware

The first time you start NEO Share, a Renaissance Learning Registration 
window will open, asking you to register your software. Registration on the 
Renaissance Learning Web site gives you access to product tips and other 
useful information as well as notifications of product updates.

Click Now to register now, Later to be reminded in 2 weeks, or Never to 
continue without registering and without further reminders.

If you click Now, you will go to the Renaissance Online Plus page on the 
Renaissance Learning Web site. There, you can log in if you have already set 
up a free account, or you can click Create an Account to set one up now. 
After you log in, you can select your products and the information you would 
like to receive. When you have submitted your changes, click Done at the 
bottom of the window.
3
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G E T T I N G  S T A R T E D  W I T H  N E O  S H A R E

The NEO Share Window

. .
 . 

. .
The NEO Share  Window

The Three Par ts  of  the  NEO Share  Window

NEO Share has a Pickup Zone A, a list of Files for Pickup B, and a list of 
Files Received C. This manual explains how to use each part of the window.

The NEO Share window becomes transparent when you click on other 
programs so that it does not completely cover the programs.

If you click the status bar D, you will see the minimized or bar form of NEO 
Share, which also has a Pickup Zone, Files for Pickup section, and Files 
Received section. For more information, see the next page.

A

B C

D
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G E T T I N G  S T A R T E D  W I T H  N E O  S H A R E

The NEO Share Window

. .
 . 

. .
Using NEO Share  Whi le  I t  Is  Minimized to  the  Bar  V iew

NEO Share goes to the minimized “bar” view when

• You click the status bar at the bottom of the NEO Share window.

• After 10 seconds of inactivity. (You can change this setting in the 
preferences; see page 19.)

In this view, you can still see the Pickup Zone, Files for Pickup, and Files 
Received. To use NEO Share in this view, do the following:

• Drag text or a file onto the Pickup Zone A to transfer the text into that 
zone. For more information, see page 6.

• Drag files onto Files for Pickup B to drop them into the list. (These files 
will be marked “Shared” by default.) For more information, see page 7.

• Watch the Files Received section of the bar C. When NEO Share receives 
files from NEOs, this section of the bar turns orange. For more 
information, see page 14.

• To see the full window again, click the NEO Share logo D.

• To collapse the bar to its smallest possible state (shown below), click the 
arrow E in the bar.

Once you have collapsed the bar, you can still do the following:

• Drag text or text files onto the collapsed bar. It will expand so that you can 
drag the text or file to the Pickup Zone or Files for Pickup.

• See when NEO Share has received files from NEOs. When this happens, the 
line between the NEO Share logo and the arrow F will turn orange.

• Expand to the full bar again by clicking the arrow G.

• Go back to the full window by clicking the NEO Share logo.

A B C
E

D

When you minimize 
NEO Share, it 
remembers whether 

you last used the expanded 
bar or the collapsed bar. It 
also remembers where you 
had the bar on the computer 
screen.

F

G
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SENDING TEXT WITH THE PICKUP ZONE

The Pickup Zone A holds text that you want to send to NEO 2s. To get text 
into the Pickup Zone, you can

• Type the text in the Pickup Zone that you want to send to NEO 2s.

• Copy text from another program, document, or Web page, click in the 
Pickup Zone, and paste the text in.

• Drag text from a document or Web page into the NEO Share Pickup Zone.

Only text will be pasted in; graphics will be omitted, and formatting will be 
removed. To erase text, press or click the trash icon B.

You can put some of the text in a linked file by typing <form> before that 
text and </form> after it. This text won’t be in the main file when it is picked 
up on the NEO 2, but the NEO user can open the linked file by pressing
ctrl-L. For more information about linked files, see the NEO User Manual.

When NEO Share is minimized, you can drag text or text files onto the Pickup 
Zone section of the bar C. (If the bar isn’t expanded, it will expand when you 
drag the text.) The Pickup Zone area will glow briefly when you do this.

In Windows, 
Notepad does not 
allow you to drag 

text out of a document. If 
you want to drag text from a 
.txt file, use WordPad instead 
of Notepad.

A

B

If you are using NEO 
Share in a classroom, 
linked files are a great 

way to give your class rubrics 
or additional information 
supporting an assignment.

C
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SELECTING FILES OR LESSONS FOR PICKUP

Choosing the  F i les  or  Wr i t ing  Prompts  for  Your  NEO 
Users  to  P ick  Up

In the Files for Pickup area A, you add files that you want to send to your 
NEO 2 users. These file formats can be added:

• Windows: Text (.txt) files.

• Macintosh: Text (.txt) files, .doc files, and .rtf files.

When you add files to the Files for Pickup list, graphics and formatting are 
stripped out.

On Windows 
computers only, the 
files are added to the 

NEO Share\Files for Pickup 
folder\ in the My Documents 
folder for the user who is 
logged in to the computer. You 
can change the folder location 
using the NEO Share 
preferences (see page 19).

A
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S E L E C T I N G  F I L E S  O R  L E S S O N S  F O R  P I C K U P

Choosing the Files or Writing Prompts for Your NEO Users to Pick Up

. .
 . 

. .
Dragging F i les  in to  the  F i les  for  P ickup Area

One way to add files is to drag them into NEO Share’s Files for Pickup area.

If the NEO Share window is maximized, select the files in Windows Explorer 
or a Macintosh Finder file list and drag them into the Files for Pickup area A. 
You can add more than one file at a time.

When NEO Share is minimized, you can drag files onto the Files for Pickup 
section of the bar B. (If the bar isn’t expanded, it will expand when you drag 
the file.) The Files for Pickup section will glow briefly to show the files have 
been added.

A

B
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S E L E C T I N G  F I L E S  O R  L E S S O N S  F O R  P I C K U P

Choosing the Files or Writing Prompts for Your NEO Users to Pick Up

. .
 . 

. .
Select ing  F i les  to  Add to the Fi les  for  Pickup Area wi th in  NEO Share

1. Click the open icon A.

2. In the menu, choose the type of file you want to add:

• Write On! Lessons: Choose this to select one of the writing prompts 
installed with NEO Share. For more information about the Write On! 
lessons, click the Help menu and select Using Write On! Lessons.

• Sample Linked Files: Choose this to select one of the sample linked 
files installed with NEO Share. These linked files provide rubrics for 
different types of writing assignments. Linked files are attached to the 
main file. The main file will be blank when the student picks it up on 
NEO 2, but the student can see the assignment rubric by pressing 
ctrl-L. The student can then press ctrl-L again to go back to the main 
file, where he or she can do the writing assignment.

• My Folders: These are the folders you’ve added to your favorites 
(see page 11). 

• My Websites: These are Web sites that you have added to your 
favorites (see page 11). Click the URL to open that Web site in your 
default browser so that you can copy text to use from that location. 
You can then paste the text into the Pickup Zone or into a text file that 
you can add by repeating these steps.

• Browse: Click this to browse to a file that you want to add.

A

The Write On! 
lessons and sample 
linked files are read 

only. You cannot save over 
these files, but you can save 
other files to the same 
location.

Click Manage 
Favorites to add or 
remove items from 

the My Folders and My 
Websites list. For more 
information, see page 11.
9
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S E L E C T I N G  F I L E S  O R  L E S S O N S  F O R  P I C K U P

Choosing the Files or Writing Prompts for Your NEO Users to Pick Up

. .
 . 

. .
3. If you choose Write On! Lessons, Sample Linked Files, a writing prompt 
folder, or Browse, select the file(s) that you want to add; then, click Open. 
You can select more than one file at a time by holding down the Shift key 
as you select a group of files, or by holding down the Ctrl key (Windows) 
or the 4 key (Macintosh) as you click the files.

Shar ing or  Hid ing F i les  in  the  F i les  for  Pickup Area

After adding files to the Files for Pickup area, you can decide which files you 
want your NEO users to see now, and which files you want to hide. 

Just click the icon A next to each file to change between the  and  icon.

When the icon is , NEO users connected to your Receiver can see and pick 
up the files.

When the icon is , NEO users cannot see or pick up the files.If you are a teacher, at 
the beginning of the 
day you can add all 

the files that you will need 
for your classes that day. As 
you work with each class, 
clicking the icon next to each 
file lets you choose which files 
that class will see.

If you see the  
icon next to a file, 
that file has been 

deleted from its original 
location, or that location is not 
available. This can happen 
when you select a file from a 
network drive that isn’t always 
available.

A
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S E L E C T I N G  F I L E S  O R  L E S S O N S  F O R  P I C K U P

Adding or Removing Your Favorite Folders and Web Sites

. .
 . 

. .
Adding or  Removing Your Favori te  Folders and Web Sites

Follow these instructions to choose which folders and Web sites will be 
available when you click the open icon in the Files for Pickup area.

1. Click the open icon A and click Manage Favorites B.

A

B
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S E L E C T I N G  F I L E S  O R  L E S S O N S  F O R  P I C K U P

Adding or Removing Your Favorite Folders and Web Sites

. .
 . 

. .
2. In the Manage Favorites 
window, follow the steps below 
for what you want to do. Then, 
click OK (Windows) or Done 
(Macintosh).

Adding Folders with Writing Prompt Files
There are two ways to add folders:

• Drag the folder from Windows Explorer or the Macintosh Finder into 
the Manage Favorites window.

• Click Add (Windows) C or + (Macintosh). Browse to the folder that 
you want to add. Then, click Add.

Adding Web Sites with Source Text
1. Open the Web site in your browser. Then, select the address (URL) and 

either drag it into the Manage Favorites window or create a shortcut to it 
somewhere on your computer.

2. If you dragged the Web site address into the Manage Favorites window, 
go to step 3.

If you created a shortcut to the Web site (or if you already have one), click 
Add (Windows) C or + (Macintosh). Browse to the shortcut that you want 
to add. Then, click Add.

3. Enter a name for the Web site; then, click Add. The Web site will be 
added to the list in the Manage Favorites window.

Removing Folders or Web Sites from Your Favorites
1. In the Manage Favorites window, check the box next to each folder and/or 

Web site that you want to remove.

2. Click Remove (Windows) D or – (Macintosh) to remove the item(s) from 
the list.

C D
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S E L E C T I N G  F I L E S  O R  L E S S O N S  F O R  P I C K U P

Removing a File from the Files for Pickup List

. .
 . 

. .
Removing a  F i le  f rom the  F i les  for  P ickup L is t

To remove a file from the Files for Pickup list (but not its original location), 
follow these steps:

1. Check the box next to the names of the files that you want to remove A. 
If you want to check all the files in the list, check the box next to Files for 
Pickup B above the list.

2. Click the trash icon C.

3. Click Yes if the program asks if you are sure that you want to remove the 
files. (Check the box if you don’t want to see the message again when 
you remove files.)

Opening a  F i le  in  the  F i les  for  P ickup L is t

Double-click a file in the Files for Pickup list to open it. The file will open 
using your default program for the type of file you have chosen.

When you remove a 
file from Files for 
Pickup, the file is not 

removed from its original 
location.

A

B C
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RECEIVING FILES FROM NEOS

Moni tor ing  the  F i les  Received

The Files Received area A lists the files that have been sent back to you from 
NEO 2 users. Depending on what you choose in the preferences (see page 19), 
this list may show the file names chosen by your NEO users or anonymous file 
names (File 1, File 2, etc). The files in this list are also saved in your default 
NEO Share folder in the Files Received subfolder; the preferences set the 
location of the NEO Share folder (see page 19).

When NEO Share is minimized to its expanded bar, the Files Received area of 
the bar B turns orange when you receive files.

When NEO Share is minimized to the 
collapsed bar, the vertical line between the 
logo and the arrow C turns orange when 
you receive files.

You can drag a file 
from Files Received 
to Files for Pickup if 

it contains something (such as 
a writing idea) that you want to 
send to all your NEO users.

A

B

C
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R E C E I V I N G  F I L E S  F R O M  N E O S

Deleting Files Received

. .
 . 

. .
Delet ing  F i les  Received

To delete files from the Files Received list and from the default directory on 
your computer, follow these steps:

1. Check the boxes next to the files you want to delete A. If you want to 
delete all of the files, check the box next to Files Received above the
list B.

2. Click the trash icon C.

3. Click Yes if the program asks if you are sure that you want to delete the 
files. (Check the box if you don’t want to see the message again when 
you delete files.)

Saving and Clear ing  F i les  Received

To save files you have received and clear them from the list, follow these 
steps:

1. Check the boxes next to the file names (A above).

2. Click the save icon (D above).

To avoid losing files 
that you may need 
later, consider saving 

and clearing the files instead 
of deleting them. See the 
instructions below.

A

D CB
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R E C E I V I N G  F I L E S  F R O M  N E O S

Opening the Files Received

. .
 . 

. .
3. In the window that opens, choose the folder where you want to save the 
files; then, press or click OK. The preferences determine the default 
location (see page 19), but you can choose to save the files somewhere 
else.

When you save files, a new folder is created in the location that you 
select. The folder name starts with “NEO Share” and ends with the date.

Opening the  F i les  Received

There are three ways to open the files you’ve received from your NEO users:

• Double-click a file in the Files Received list. The file will open in the default 
program for text files. On Windows computers, it may be helpful to set 
WordPad as your default program for text files to give you more options as 
you work with the file.

• Open a text-editing program, such as WordPad, and open a new document. 
In NEO Share, click a file in the Files Received list and drag it into the 
program you have opened. The text of the file will appear in that program.

• On Macintosh computers, if you have a text-editing program in the dock, 
you can drag the file onto the program icon in the dock to open it in that 
program.

Adding F i les  to  the  F i les  Rece ived L is t

If you received some files from your NEO 2 users another way, you can drag 
them from Windows Explorer or a Macintosh Finder file list into the Files 
Received area of NEO Share. The files will be added to the list.

If the file that you 
received had any 
text in a linked file on 

NEO 2, that text will appear 
within <form> and </form> 
tags at the end of the received 
file.
16
NEO Share

User Manual



NEO 2 USERS: PICKING UP AND SENDING FILES

How NEO 2  Users  P ick  Up Text  or  F i les

Make sure your Renaissance Receiver is connected to your computer, and 
make sure your NEO 2 users know the Receiver name. Then, ask your NEO 2 
users to follow these steps to pick up the text from your Pickup Zone or files 
from your Files for Pickup list:

1. Press one of the file keys to choose where you want to pick up the text or 
file.

2. Press cmd-O.

3. If any text is in the file, NEO 2 will ask if you want to keep the current file. 
If you want to keep it, press Y for yes, enter a name for the file, and press 
enter. If not, press N for no and press enter.

4. NEO 2 will search for your network (Receiver).

If you have connected to a Receiver before, NEO 2 will ask if you want to 
stay connected to that network. If you want to connect to the same 
Receiver, press Y for yes, then enter and go to step 5. If you need to 
choose a different Receiver, press N for no, then enter.

If you haven’t connected to a Receiver before, or if you have and you 
chose not to stay connected to the same one, the screen will list the 
Receivers that are in range. Press  until you have highlighted the 
Receiver you want to connect to; then, press enter.

5. On the Open From 
screen, use the arrow 
keys to highlight NEO 
Share and press 
enter.

6. If there is only one file available for pickup, skip this step and go to step 7.

If there is more than 
one file available, you 
will see a list of the text 
and files that you can 
pick up. Text is shown 
as << Pickup Zone >>. Files are identified by file name. The dates show 
when the Pickup Zone text was added and when the files were last saved. 
Use the arrow keys to highlight the file you want and press enter.
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N E O  2  U S E R S :  P I C K I N G  U P  A N D  S E N D I N G  F I L E S

How NEO 2 Users Send Files Back to NEO Share

. .
 . 

. .
7. You may see messages telling you that NEO 2 is communicating with 
NEO Share and then copying from NEO Share.

The text or file that you chose will appear in the NEO 2 file space that you 
had open. If there is a linked file, press ctrl-L to see it.

How NEO 2  Users  Send F i les  Back  to  NEO Share

Make sure your Renaissance Receiver is connected to your computer, and 
make sure your NEO 2 users know the Receiver name. Then, ask your NEO 2 
users to follow these steps to send their files back to NEO Share. (The files 
they send will also remain on NEO 2.)

1. Open the file that you want to send back to NEO Share.

2. Press cmd-send.

3. If you have shut the NEO 2 off since you last connected to the Receiver, 
one of the following will happen:

• If you have connected to a Receiver before, NEO 2 will ask if you want 
to stay connected to that network. If you want to connect to the same 
Receiver, press Y for yes, then enter and go to step 4. If you need to 
choose a different Receiver, press N for no, then enter.

• If you haven’t connected to a Receiver before, or if you have and you 
chose not to stay connected to the same one, the screen will list the 
Receivers that are in range. Press  until you have highlighted the 
Receiver you want to connect to; then, press enter.

4. On the Open From screen, use the arrow keys to highlight NEO Share 
and press enter.

5. You may be asked to enter a name for the file. If so, type a name for the 
file that you are sending; then, press enter. The person who receives it in 
NEO Share decides whether to show the file name you choose or an 
anonymous file name.

6. You may see messages telling you that NEO 2 is communicating with 
NEO Share and then copying to NEO Share. When the screen shows you 
that NEO 2 has finished copying the file to NEO Share, press enter.

If NEO Share is 
minimized at the 
computer, when it 

receives the file, the Files 
Received section of the bar 
will turn orange to show you 
that files have come in. If the 
NEO Share bar is collapsed, 
the vertical bar next to the logo 
will turn orange when files are 
received.
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SETTING THE NEO SHARE PREFERENCES

1. On Windows computers, click the Edit menu in NEO Share and choose 
Preferences.

On Macintosh computers, click the NEO Share menu and choose 
Preferences.

The Preferences window will open.

2. Check Require files to be named before sending A if you want to 
require NEO 2 users to enter a file name for the files they send back. 
When this is not checked, the files will be named File 1, File 2, etc.

3. Check the Append date to filenames box B if you want the date to be 
added to the end of the file name.

4. Check the Display anonymous filenames box C if you want NEO 
Share to display anonymous file names (such as File 1, File 2, etc.) 
instead of the names that your NEO 2 users entered. If you are using a 
projector or interactive whiteboard and your users can see the list of Files 
Received in NEO Share, you may want to use anonymous file names.

5. Check the first box under General D if you want NEO Share to minimize 
automatically after a certain number of seconds of inactivity. Then, use 
the arrows E to choose how many seconds the program should wait 
before minimizing, or enter a new value (up to 100 seconds).

6. Check Display warning when deleting files F if you want to be asked if 
you are sure you want to delete files whenever you choose to do so.

A
B

C

D

G

E

F

19
NEO Share
User Manual



C L O S I N G  T H E  P R O G R A M

. .
 . 

. .
7. The default folder (directory) G is where NEO Share saves Files for 
Pickup (Windows only), Files Received, and files that you choose to save. 
When you first install NEO Share, the default folder is set as a NEO Share 
folder within your personal My Documents or Documents folder 
(depending on your operating system). The NEO Share folder includes 
the following subfolders:

• Files for Pickup (Windows only): When you add Files for Pickup, 
they are saved in this subfolder.

• Files Received: Files that you receive from your NEO 2 users are 
saved in this subfolder.

• Saved Files: This is the default location for the files that you save 
from the Files Received list. However, as you save files, you can 
choose a different location. Every time you save files to the Saved 
Files folder, a new subfolder that includes the date is created inside 
the Saved Files folder.

To change the default location for the NEO Share files, press or click 
Browse and either open a different folder or create a new folder. With the 
folder highlighted, press or click OK (Windows) or Open (Macintosh). If 
you choose a different folder, the files that were in your original folder will 
not be moved, but new Files for Pickup or Files Received will be saved to 
the new location.

8. To save your changes to the preferences, click OK.

CLOSING THE PROGRAM

To close the program, click the X in the red square (Windows) or circle 
(Macintosh) in the window or on the minimized NEO Share bar.

On Windows computers, you can also click the File menu and choose Exit.

On Macintosh computers, you can click the NEO Share menu and choose 
Quit NEO Share.

If the folder shown in 
the preferences is 
removed outside of 

NEO Share, or if it is not 
available, NEO Share will 
notify you.
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